




WARRANTY
With respect to the physical CD and physical documentation enclosed herein, AEMC® Instru-
ments warrants the same to be free of defects in materials and workmanship for a period of 
one year from the date of purchase. In the event of notification within the warranty period 
of defects in material or workmanship, AEMC® Instruments will replace the defective CD or 
documentation. The remedy for breach of this warranty shall be limited to replacement and 
shall not encompass any other damages, including but not limited to, loss of profit, special, 
incidental, consequential, or other similar claims.
AEMC® Instruments specifically disclaims all other warranties, expressed or implied, includ-
ing but not limited to, implied warranties of merchantability and fitness for a particular pur-
pose with respect to defects in the CD and documentation, and the program license granted 
herein in particular, and without limiting operation of the program license with respect to any 
particular application, use or purpose. In no event, shall AEMC® Instruments be liable for any 
loss of profit or any other commercial damage, including but not limited to, special, incidental, 
consequential or other damages.
What You Must Do: First request a return authorization form by phone or by fax from AEMC® 
Instruments, then return the CD along with the signed authorization repair form. Return mate-
rial, postage pre-paid to:
	 Chauvin Arnoux®, Inc. d.b.a. AEMC® Instruments
	 15 Faraday Drive • Dover, NH 03820 USA
	 Tel: (800) 945-2362 or (603) 749-6434 • Fax: (603) 742-2346

COPYRIGHT
Copyright 2000 by AEMC® Instruments. All rights reserved.
	 Chauvin Arnoux®, Inc. d.b.a. AEMC® Instruments
	 15 Faraday Drive • Dover, NH 03820 USA
	 Tel: (800) 945-2362 or (603) 749-6434 • Fax: (603) 742-2346
	 All rights reserved.

Acknowledgements for product names used in this manual belong to the following compa-
nies: Windows® is a registered trademark of Microsoft Corp. Acrobat® Reader is a registered 
trademark of Adobe Systems Incorporated.

DISCLAIMER
The DataView® software and this documentation are provided “AS IS”, without warranty of 
any kind. By using this program (the DataView® software) you are assuming all liability for 
anything which might occur, including but not limited to physical, emotional or monetary 
damages.
AEMC® Instruments has made every attempt to ensure that this program operates properly. 
Due to the complexity of any program of this size, a change made in one part of the pro-
gram can, and sometimes does, inadvertently generate problems in other areas. It is recom-
mended that you save your work regularly (BACK UP your software).
No part of this manual or software may be reproduced in any form, or by any means (includ-
ing electronic storage and retrieval or translation into any other language) without prior 
agreement and written consent from AEMC® Instruments, as governed by United States and 
International copyright laws.
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CHAPTER 1

SOFTWARE INSTALLATION

1.1	 Installing DataView®

	
DO NOT CONNECT THE INSTRUMENT TO THE PC BEFORE INSTALLING THE 
SOFTWARE AND DRIVERS.

Minimum Computer Requirements:
•	 Windows XP / Windows Vista & Windows 7/8 (32/64 bit)
•	 256MB of RAM for Windows XP 

1GB of RAM for Windows Vista & Windows 7/8 (32 bit) 
2GB or RAM for Windows Vista & Windows 7/8 (64 bit)

•	 80MB of hard disk space (200MB recommended)
•	 USB port

Windows® is a registered trademark of Microsoft Corporation in the United States and other countries.

NOTE: When installing, the user must have Administrative access 
rights during the installation. The users access rights can be changed 
after the installation is complete. DataView® must be reinstalled for 
each user in a multi-user system. 

USB Flash Drive Install

1.	 Insert the USB stick into an available USB port (wait for driver to be 
installed).

2.	 If Autorun is enabled then an AutoPlay window should appear as 
shown.

Figure 1-1
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NOTE: If Autorun is disabled, it will be necessary to open Windows Explorer, 
then locate and open the USB stick drive labeled “DataView” to view the files 
on the drive.

3.	 In the AutoPlay window, select “Open folder to view files”.

4.	 Double-click on Setup.exe from the opened folder view to launch the 
DataView setup program.

5.	 A Set-up window will appear. Click Install and follow the on-screen 
instructions to complete the install.

Figure 1-2

There are several different options to choose from. Some options(*) require 
an internet connection.

•	 DataView, Version x.xx.xxxx - Installs DataView® onto the PC.

•	 *Adobe Reader - Links to the Adobe® website to download the 
most recent version of Adobe® Reader to the computer. Adobe® 
Reader is required for viewing PDF documents supplied with 
DataView® that are accessible from the Help menu.

•	 *DataView Updates - Links to the online AEMC® software 
updates to check for new software version releases.

•	 *Firmware Upgrades - Links to the online AEMC® firmware 
updates to check for new firmware version releases.
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•	 Documents - Shows a list of instrument related documents 
that you can view.  Adobe® Reader is required for viewing PDF 
documents supplied with DataView®.

3.	 DataView, Version x.xx.xxxx option should be selected by default. 
Select the desired language and then click on Install.

4.	 The Installation Wizard window will appear. Click Next.

5.	 To proceed, accept the terms of the license agreement and click Next. 

6. 	 In the Customer Information window, enter a Name and Company, 
then click Next.

7.	 In the Setup Type window that appears, select the “Complete” radio 
button option, then click Next.

8.	 In the Select Features window that appears, deselect the instrument’s 
control panel that you do not want to install, then click Next.

	
NOTE: The PDF-XChange option must be selected to be able to generate 
PDF reports from within DataView®.

Figure 1-3

9.	 In the Ready to Install the Program window, click on Install.

10.	 If the instrument selected for installation requires the use of a USB 
port, a warning box will appear, similar to Figure 1-4. Click OK.
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Figure 1-4

	
NOTE: The installation of the drivers may take a few moments.  Windows may 
even indicate that it is not responding, however it is running. Please wait for 
it to finish.

11.	 When the drivers are finished installing, the Installation Successful 
dialog box will appear. Click on OK. 

12.	Next, the Installation Wizard Complete window will appear. Click on 
Finish.

13.	A Question dialog box appears next. Click Yes to read the procedure 
for connecting the instrument to the USB port on the computer.

	
NOTE: The Set-up window remains open. You may now select another option 
to download (e.g. Adobe® Reader), or close the window.

14.	Restart your computer, then connect the instrument to the computer.

15.	Once connected, the Found New Hardware dialog box will appear. 
Windows will complete the driver installation process automatically.

Shortcuts for DataView® and each instrument control panel selected during 
the installation process have been added to your desktop.

	
NOTE:  If you connected your instrument to the computer before installing 
the software and drivers, you may need to use the Add/Remove Hardware 
utility to remove the instrument driver before repeating the process.
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CHAPTER 2

USING DATAVIEW®

This chapter will provide the information necessary to use this program. 
More information on specific functions available in DataView® is available 
in the online help system included with the software and the product user 
manual supplied with each instrument.

2.1	 Overview
DataView® software allows the user to analyze and display recorded data, 
while the instrument’s Control Panel controls, configures and downloads 
data from the instruments.

	
NOTE: Information regarding downloading data and using the instrument’s 
Control Panel can be found in the associated product’s user manual. 

DataView® can access raw recorded data from instruments in two ways. It 
can open .dvb files to use or it can have data sent to a report by selecting 
Create DataView Report from the instrument’s Control Panel. 

When test data is sent to DataView® using Create DataView Report in the 
Control Panel, a new report is automatically created.

Once this is done, a standard report will open displaying data and graphs 
from the test. Initially this is the default template but the user has the ability 
to customize the report once it is opened and has the option of saving the 
new form as a new template.

When saving as a template it cannot over write templates supplied with 
DataView. It must be saved under a new name. The default template used 
to create reports can be changed in each of the instrument associated 
control panels.  For information about how to change the default template 
used by a control panel refer to the documentation for the associated con-
trol panel.
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While it is possible to create a template or report from scratch, it is easier 
and faster to use or modify the included templates (see § 6). 

A report can be saved at any time using the Save function. It will be stored 
as a .dvw file, but in order to use the modified layout of the report for other 
tests, it is necessary to save the template using the Save As Template 
option from the File menu, this will save it as a .dvt file. 

	
NOTE: When using Save As Template, the template can be saved with or 
without the database content.  Saving with the database content allows the 
template to be opened and modified as it existed when first created.  If saved 
without the database content a database must be selected when opening the 
template for modification.  The advantage of saving without the database con-
tent is that the resulting template file is much smaller that with the database 
content.  This is especially true if it is a very large database.  It is much easier 
to modify and maintain a template if the database content is saved with it. 

When the template is used on a new set of data from the same type of test, 
the resulting report will have the same layout as that defined in the template, 
but with the new data inserted.

Once the report has been created, it is possible to move between the 
worksheets using the tabs on the bottom of the screen. The first worksheet 
in the report is always the Cover Sheet which displays information 
pertaining to the instrument, the test run and the user. 

The top box on the Cover Sheet worksheet is automatically filled in with 
test and instrument information that is attached to the test data. The 
“Operator” and “Test Site” boxes can be filled by first selecting the 
desired box, then selecting Edit Session Properties from the Edit menu. 
To edit the information and add “Comments”, double-click on the boxes. 
This opens up a window that allows the content that is shown in each box 
to be edited. 

Frames are boxes within the report that contain and display text, data, 
graphs or images. When the report is first created all the frames are 
locked (provided they were locked in the template), this prevents them 
from being resized, deleted, moved and otherwise edited. Therefore, to 
make changes to a frame it needs to be unlocked. This is done by right-
clicking on the frame and selecting Unlock Frame. 

To create a new frame, select New Frame from the Frame menu or choose 
the specific type of frame from the choices displayed. Frames allow graphs, 
text boxes and other objects to be placed on the worksheet. 
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Once a frame type has been selected, click and drag over the area of the 
worksheet where the frame is to be placed. It can be moved and resized 
later. After placing the frame, a dialog box will appear prompting the data 
type or object to put in the frame. 

Linked Frames are frames that allow additional data to be displayed 
pertaining to another frame, such as waveforms and harmonics. To create 
a linked frame, select the graph frame that you want to link it to, then select 
Link Frame from the Frame menu.

Once Link Frame is clicked, there will be a prompt to select the type 
of linked frame to be created. Once this is chosen, place the frame by 
clicking and dragging over the area where the frame is to be placed on the 
worksheet. Following the placement of the Linked Frame, a dialog box will 
appear allowing the user to select the options for this frame.

It is possible to add and delete worksheets from a report, allowing the 
user to customize the length of the report. To add a worksheet, select Add 
Worksheet from the Edit menu. To remove a worksheet, select Delete 
Worksheet from the Edit menu.

The graphs have zooming and panning functions allowing the user to 
enlarge portions of the graph and scroll through them. The functions are 
accessed through their buttons on the toolbar or the Zoom menu.

	
NOTE: For more information, use the software’s “Help” Menu, which is 
installed with DataView® (see § 3.9).

DataView® provides the following features (instrument dependent):

•	 Display and analyze data on your PC
•	 Configure all instrument functions and parameters
•	 Customize frames, templates and reports
•	 Display real-time data
•	 Download previously recorded data
•	 Create and store a complete library of configurations that can be 

uploaded to the instrument as needed
•	 Factory predefined templates for each type of instrument
•	 Display waveforms, trend graphs, harmonic spectrums and text 

summaries
•	 Display surge & sag events in high-resolution waveforms and as 

tabular listings
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2.2	 Starting DataView®

Start the DataView® program by selecting its shortcut from Programs in 
the Start Menu or from the Desktop Shortcut. The Quick Start dialog box 
will appear.

Figure 2-1

•	 Configure Instrument: Opens an instrument specific control panel, 
which displays the Configure Instrument dialog box.

•	 Real-time Display: Opens an instrument control panel providing 
real-time display of measurement data.

•	 Download Data: Opens an instrument control panel and begins the 
download of recorded data.

•	 Open Data File: Displays the Create View from Template dialog 
box, which allows an existing database using a user customized or 
predefined template to be opened.

•	 Open Existing Report: Opens previously created reports (.dvw) and 
recently used databases (.dvb). When a file is selected from this list 
it will automatically open, if it is a database it will first prompt for the 
desired template to use. 

•	 Check for DataView Updates: This button opens the internet 
browser to see if a new version of DataView® is available online. 
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2.3	 Exiting DataView®

To exit, select Exit from the File menu. If any of the loaded files have been 
modified since they were last saved, a dialog box will appear.
Selecting Yes will save the specified report. Selecting No will continue 
with the exit process and not save the specified report. Selecting Cancel 
will stop the exit process and return to normal program operation.

2.4	 Creating a New Worksheet
Create a blank worksheet by selecting New from the File menu. A blank 
page is displayed with the Basic toolbar across the top.

To view and use the Advanced toolbar, click View > Toolbar > Advanced 
or click on the Advanced icon  (see § 2.5).

Worksheets are used to display and contain all report objects (graphs, 
tabular summaries, text boxes, etc.) within frames placed on the page. 
Frames are discussed in Chapter 4.

Figure 2-2



14	 DataView® User Manual

2.5	 Toolbars

2.5.1	 Basic Toolbar

The Basic toolbar consists of the following buttons:

	 Home	 Save	 Print	 Insert Text	 Insert Data	 Advanced Tools

Figure 2-3

2.5.2	 Advanced Toolbar

Items on the Advanced toolbar fall into two categories:

•	 Tools: Changes the mouse pointer to a corresponding DataView® 
tool and requires additional user action.

•	 Buttons: Perform the desired operation when the button is 
pressed (no other action is required).

Tooltips can be displayed by hovering over an icon.

To hide or display the Toolbar, choose View > Toolbar > Hide.

 

Figure 2-4

	
NOTE: For a complete description of all toolbar icons, from within DataView 
software, go to Help > Help Contents > Chapter 1.4.

2.6	 Tabs Bar
The Tabs bar is located right above the Status bar at the bottom of the 
DataView® window:

Figure 2-5
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The Tabs bar shows all the worksheets in the current report and allows the 
user to move between worksheets by clicking the appropriate tab. If there 
are more worksheets then there is space for tabs, then arrows will appear 
to scroll through the list of tabs. 

2.7	 Status Bar
The status bar is located at the very bottom of the DataView® window. To 
display or hide the status bar, choose Status Bar from the View menu.

Figure 2-6

On the left side of the status bar is a one-line prompt about highlighted 
menu options. If no menu option is highlighted, it informs you that pressing 
the F1 function key will display the online help.

On the right side of the status bar are four panes. The first indicates the 
current worksheet and number of pages in the report. The last three panes 
indicate the number of worksheets in the report and the state of the Caps 
lock, Num lock and Scroll lock keys.

2.8	 Title Bar

Figure 2-7

The title bar is located along the top of the DataView® application window 
and contains the name of the application and active report.

To move the window, drag the title bar.

	 NOTE: You can also move dialog boxes by dragging their title bars.

2.9	 Scroll Bars
The scroll bars are displayed at the right and bottom edges of the report. 
Use the mouse to scroll through the pages using the horizontal and verti-
cal scroll bars.
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2.10	 Changing the Page Layout
The layout and size of the pages used in a report is defaulted at 8.5 x 11" 
with a 0.5" margin around all sides.

To change the page layout, perform the following steps:

1.	 Select Page Setup from the File menu. The Page Setup dialog box 
will be displayed. This dialog box allows you to select the paper size 
and source. The default printer determines both of these. To select an 
alternate printer, click on the Printer button.

	 NOTE: Page setup is only available when a report is open.

2.	 Select the size and paper source from the drop-down menus.

3.	 Select the appropriate page orientation (portrait or landscape).
4.	 Specify the left, right, top and bottom margins.

5.	 Select the OK button to change the page layout for the active report to 
the specified settings.

	
NOTE: When the file is saved, the changes you make to the page layout are 
saved for the current file only. When creating a new document, the default 
page size will apply.

2.11	 Adding and Deleting Worksheets
To Add a worksheet, perform the following steps:

1.	 Select the Add Worksheet command from the Edit menu. The Insert 
Worksheet dialog box will be displayed.

2.	 Specify the worksheet number and whether it should come before or 
after the currently displayed worksheet.

3.	 Click OK to proceed.

To Delete a worksheet, perform the following steps:

1.	 Select the Delete Worksheet command from the Edit menu. The 
Delete Worksheet dialog box will be displayed.

2.	 Specify the number of the worksheet you wish to delete.

3.	 Click OK to proceed.
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2.12		  Printing
To print the active (currently displayed) worksheet in a report, select the 

Print Worksheet command from the File menu or click on the  icon.
To print all the worksheets in a report, select the Print All Worksheets 
command from the File menu.

The Print dialog box will appear. This dialog box allows you to select a 
printer and change its properties.

2.13	 Print Preview
The Print Preview command displays the active worksheet as it would 
appear when printed.

	
NOTE: Print Preview only shows the current worksheet and not the entire 
report.

To use this command, select Print Preview from the File menu, or select 

the  icon.

Print Preview offers the following options:

•	 Print: Brings up the print dialog box to start a print job.

•	 Next Page: Previews the next printed page in the worksheet.

•	 Prev Page: Previews the previous printed page in the worksheet.

•	 One Page / Two Page: Previews one or two pages at a time.

•	 Zoom In: Takes a closer look at the printed page.

•	 Zoom Out: Takes a larger look at the printed page.

•	 Close: Returns from print preview to the editing window.

2.14	 Getting Online Help
Context sensitive help is available in DataView® by pressing the F1 func-
tion key or by selecting Contents from the Help menu. Many dialog boxes 
also have a Help button.
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CHAPTER 3

MENU COMMANDS

	
NOTE: The Menu content will only display the active commands that are 
available for the Window that is currently selected.

3.1	 File Menu
•	 Quick Start: Opens the DataView® Quick Start dialog box

•	 New: Creates a new report

•	 New From Template: Opens the Create Report from Template 
dialog box

•	 Open: Opens an existing report

•	 Close: Closes the active report

•	 Save: Saves the active report using the same file name

•	 Save As: Saves the active report to a specified file name

•	 Save As Template: Saves the active report as a Template

•	 Archive: Copies the active report and all of the attached database 
files to a user specified location

•	 Database: Displays the Database Properties dialog box

•	 Export to Spreadsheet: Exports the data report to a *.csv spread-
sheet

•	 Page Setup: Displays the Page Setup dialog box

•	 Print Worksheet: Prints the active worksheet

•	 Print All Worksheets: Prints all the worksheets in a report.

•	 Print Preview: Displays the report on the screen as it would 
appear printed
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•	 Generate PDF: Creates a user friendly PDF of the worksheet for 
sharing with others that do not have DataView® installed

•	 Send: Sends the active report through electronic mail

•	 Exit: Exits DataView®

3.2	 Edit Menu
•	 Undo: Reverses previous editing operation

•	 Redo: Reverses the last undo command

•	 Cut: Deletes a selected item and moves it to the clipboard

•	 Copy: Copies a selected item to the clipboard

•	 Paste: Pastes an item from the clipboard

•	 Paste Special: Pastes data from the Windows® clipboard

•	 Add Worksheet: Adds a worksheet to the active report

•	 Delete Worksheet: Deletes a worksheet from the active report

•	 Rename Worksheet: Allows the user to rename the worksheet

•	 Duplicate Worksheet: Duplicates the currently selected work-
sheet (including all frames on that page)

•	 Move Worksheet: Allows the current worksheet to be moved 
before or after another worksheet

•	 Edit Session Properties: Allows the session properties to be 
edited for the current report

•	 Insert New Object: Inserts and embeds an object into a report

•	 Links: Lists and edits links to embedded objects

•	 Object: Edits the selected object
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3.3	 View Menu
•	 Draft: Shows the active report in draft mode

•	 Layout: Shows the active report in layout mode

•	 Links: Displays the child/parent links between frames

•	 Watch: Enables/disables the value at cursor display on graphs

•	 Grid: Enables/disables the display and snap to grid for frames

•	 Toolbar: Allows the selection of the Basic or Advanced toolbars 
and whether to show or hide the toolbar

•	 Status Bar: Shows or hides the status bar

3.4	 Frame Menu
•	 Select Frame: Changes the pointer to the Frame Selection tool

•	 Link Frame: Enables the Link Frame tool, for creating a new 
frame linked to the currently selected frame

•	 Change Link: Allows you to assign another frame as the parent of 
a child frame

•	 Properties: Displays the properties dialog box associated with 
the currently selected frame

•	 Frame Background: Displays the Color dialog box, which allows 
the change of color to the frame’s background.

•	 Send To Back: Moves selected frame to the end of the reports 
frame list

•	 Bring To Front: Moves selected frame to the beginning of the 
reports frame list

•	 Lock Frame: Locks the frame at its current position and size

•	 Unlock Frame: Releases a locked frame

•	 New Frame: Creates a new object frame on the report

•	 Place Graph: Places a graph on the report

•	 Place TOC: Places a table of contents on the report
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•	 Place Text: Places a text box on the report

•	 Place OLE: Places an OLE object on the report

•	 Place Word OLE: Places a Word OLE object on the report

•	 Draw Arrow: Changes the pointer to the Arrow tool

•	 Draw Line: Changes the pointer to the Line tool

•	 Draw Box: Changes the pointer to the Box tool

3.5	 Zoom Menu
•	 Zoom Tool: Enables the zoom selection tool

•	 Zoom In: Increases the zoom magnification

•	 Zoom Out: Decreases the zoom magnification

•	 Zoom Previous: Zooms to the previous display extents

•	 Zoom All: Sets the display extents to include all stored data

•	 Step Left: Pans the displayed graph to the left by 10%

•	 Step Right: Pans the displayed graph to the right by 10%

•	 Pan Left: Pans the displayed graph to the left by 90%

•	 Pan Right: Pans the displayed graph to the right by 90%

•	 Pan Start: Pans the displayed graph to the start of stored data

•	 Pan End: Pans the displayed graph to the end of stored data

3.6	 Instrument Menu Commands
•	 Control Panel: Establishes a connection to an instrument and 

opens the instrument’s Control Panel

•	 Configure Instrument: Establishes a connection to an 
instrument and displays the Configure Instrument dialog box

•	 Download: Opens the control panel associated with the 
instrument and retrieves and saves previously recorded 
measurements



22	 DataView® User Manual

3.7	 Tools Menu Commands
•	 Control Panel Options: Displays the Control Panel Options 

dialog box

•	 Directories: Displays the Default Directories dialog box

•	 General Options: Allows changes to the measurement units and 
numeric format

3.8	 Window Menu Commands
•	 New Window: Creates a new window that displays the same 

report

•	 Cascade: Arranges windows in an overlapped fashion

•	 Tile: Arranges windows in non-overlapped tiles

•	 Arrange Icons: Arranges icons of closed windows

•	 Window 1, 2, ...: Goes to specified window

3.9	 Help Menu Commands
•	 Contents: Offers an index to the help topics

•	 Register: Opens the internet browser for product registration

•	 Update: Checks for the most recent version of DataView®

•	 About: Displays the software version number
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CHAPTER 4

FRAMES

4.1	 What are Frames?
Frames are rectangular boxes in which graphical items such as lines, text 
and graphs are drawn. All items displayed by DataView® are contained in 
frames.

4.2	 Creating and Placing Frames
To create a frame on a page, select one of the frame tools, then click and 
drag an area for the frame to be placed.

The type of frame created depends on the tool selected from the toolbar:

	 Link Frame tool: creates a new frame linked to the currently 
selected frame (Parent and Child Frames)

	 New Frame tool: creates any of the frames listed below, or one 
that is not covered by any of the specific tools

	 Place Graph tool: creates a waveform or trend frame

	 Place TOC tool: creates a Table of Contents frame

	 Insert Text tool: creates a Text frame

	 Insert Object tool: creates an OLE (Object Linking and Embed-
ding) frame. This frame is used to embed or link items from other 
applications into the report

	 Place Word OLE tool: creates a Word OLE

	 Draw Arrow tool: creates an Arrow frame

	 Draw Line tool: creates a Line frame

	 Draw Box tool: creates a Box frame
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NOTE:  Frame Properties can be modified at any time by either double-
clicking on the associated frame, right-clicking and selecting Properties from 
the pop-up menu or by selecting the frame then selecting Properties from the 
Frame menu.

4.3	 Text Frames
A Text Frame creates a frame where text can be inserted.

4.3.1	 Creating a Text Frame

To place a Text Frame on the page perform the following steps:

1.	 Select the Insert Text  tool.
2.	 Move the tool to the location on the page where the upper left corner 

of the frame is to be placed.
3.	 Click and drag the mouse to the location on the page where the lower 

right corner of the frame is to be located, then release.

The Text Box Properties dialog box will be displayed:

Figure 4-1

•	 Text Box: A box to type text to be placed in the report.

•	 Tabs: Specifies the position of tabs within the frame.

•	 Font: Changes the font of the text.
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•	 Enable word wrap: When checked, wraps text within the frame.

•	 Draw box around frame: When checked, draws a box around 
the frame. 

•	 Grow frame with text: When checked, allows the frame to grow 
with the text.

4.4	 OLE Frames
An Object Linking and Embedding (OLE) Frame is used to embed or link  
items from other applications into a report. The object is contained within 
the specified frame.

4.4.1	 Creating an OLE Frame

1.	 Select the Insert Object  tool.

2.	 Move the tool to the location on the page where the upper left corner 
of the frame is to be placed.

3.	 Click and drag the mouse to the location on the page where the lower 
right corner of the frame is to be located, then release.

The Insert Object dialog box will be displayed:

Figure 4-2

•	 Create New: Creates a new object to embed onto the page.

•	 Create from File: Embeds an existing file onto the page.
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•	 Object Type: A list of available programs to select when creating 
a new object.

•	 Display as Icon: When checked, specifies whether the 
embedded object will appear in the report as an icon or as the 
actual object. 

For more details on OLE Frames, see § 5.

4.5	 Arrow Frames
An Arrow Frame is used to draw an arrow on a report.

4.5.1	 Creating an Arrow Frame

1.	 Select the Draw Arrow  tool.

2.	 Move the tool to the location on the page where the upper left corner 
of the frame is to be placed.

3.	 Click and drag the mouse to the location on the page where the lower 
right corner of the frame is to be located, then release.

The Arrow Properties dialog box will be displayed:

Figure 4-3

•	 Line Thickness: Specifies the line thickness (in pixels).

•	 Line Color: Changes the color of the line. Select a color from 
the Line color drop-down list. You can also specify a color, other 
than the ones in the color list, by entering the amount of each 
color component in the Red, Green and Blue fields, or click the 
color picker icon to select from a wider range of colors.

•	 Arrow head size: Specifies the size of the arrowhead.
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4.6	 Line Frames
A Line Frame is used to draw a line on a report. 

4.6.1	 Creating a Line Frame

1.	 Select the Draw Line  tool.

2.	 Move the tool to the location on the page where the upper left corner 
of the frame is to be placed.

3.	 Click and drag the mouse to the location on the page where the lower 
right corner of the frame is to be located, then release.

The Line Properties dialog box will be displayed:

Figure 4-4

•	 Line Thickness: Specifies the line thickness (in pixels).

•	 Line Color: Changes the color of the line. Select a color from 
the Line color drop-down list. You can also specify a color, other 
than the ones in the color list, by entering the amount of each 
color component in the Red, Green and Blue fields, or click on 
the color picker icon to select from a wider range of colors.
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4.7	 Box Frames
A Box Frame is used to draw a rectangular box on a report. 

4.7.1	 Creating a Box Frame

1.	 Select the Draw Box  tool.

2.	 Move the tool to the location on the page where the upper left corner 
of the frame is to be placed.

3.	 Click and drag the mouse to the location on the page where the lower 
right corner of the frame is to be located, then release.

The Box Properties dialog box will be displayed:

Figure 4-5

•	 Line Thickness: Specifies the line thickness (in pixels).

•	 Line Color: Changes the color of the line. Select a color from 
the Line color drop-down list. You can also specify a color, other 
than the ones in the color list, by entering the amount of each 
color component in the Red Green and Blue fields.

•	 Fill Style: Selects the pattern (fill) you want inside the object.

•	 Elliptical: Switches the shape from a box to an ellipse.
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4.8	 Modifying a Frame

4.8.1	 Locking and Unlocking a Frame

When a frame is placed on a report, it is unlocked and can be moved and 
resized.

A frame can also be locked to prevent it from being moved or resized. 

To lock/unlock a frame, perform the following steps:

1.	 Select the frame to be locked/unlocked.

2.	 Select the Lock Frame or Unlock Frame command from the Frame 
menu, or right-click on the selected Frame and choose Lock Frame 
or Unlock Frame from the pop-up menu.

4.8.2	 Selecting a Frame

To select a frame, use the Select Frame  tool and click on the frame.
When a frame is selected, resize handles will be displayed on each of the 
four corners and at the middle of each four sides of the frame. 
When a frame is placed on top of another frame, the top-most frame will be 
selected first. To select the underlying frame, change the order of frames 

by using the Send to Back and Bring to Front  buttons. 

4.8.3	 Resizing a Frame

	
NOTE:  If a frame is unable to be resized, it may be locked. Refer to § 4.8.1 
to unlock it.

To resize a frame, perform the following steps:

1.	 Place the mouse pointer over one of the corner resize handles. The 
pointer will change to a resize arrow indicating the direction that the 
handle will resize the frame in. 

2.	 Click on and drag the resize handle in the required direction.

	
NOTE:  Dragging one of the resize handles located in the middle of a side 
moves the corresponding side only, leaving the corners for the other side 
fixed.
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4.8.4	 Cutting, Copying and Pasting

Frames can be removed from a worksheet, or copied and pasted onto the 
same, or a different, worksheet.

To cut a frame, perform the following steps:

1.	 Select the frame to be removed.

2.	 Select the Cut command from the Edit menu or click on the Cut  
toolbar icon. The frame will be removed from the page.

	
NOTE:  A frame with attached child frames cannot be removed from the page 
before all the attached child frames are removed first.

To copy a frame, perform the following steps:

1.	 Select the frame to be copied.

2.	 Select the Copy command from the Edit menu or click on the Copy 
 toolbar icon. The frame will be copied to the clipboard.

To paste a frame, perform the following steps:

1.	 Go to the page that the frame is to be pasted on.

2.	 Select the Paste command from the Edit menu or click on the Paste 
 toolbar icon. The frame and its contents that are currently in the 

application clipboard will be placed on the displayed page.
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4.9	 Graph Frames
A Graph Frame provides a graphical look into the database to which it is 
attached. The database is attached to the frame when it is created.

Normally, the Select Frame tool is used to select a frame for modification. 
However, when used in a Graph frame it can select individual waveforms 
and trend traces.

The Graph Frame can be the Parent Frame for Child Frames (see § 4.11).
The types of Child Frames that it can support are:

•	 Waveform Analysis Frames: The types of Waveform Analysis 
include Waveform Snapshot, Harmonic Bar Graph and Harmonic 
Text Summary.

•	 Graph Legend Frame: Displays the names of the traces 
displayed on the graph.

•	 Session Summary Frame: Displays user and instruments 
supplied information about the session that contains the 
recorded data.

•	 Micro-Graph Frame: Displays a sub-section of the Parent 
Frame.

•	 Meter Frame: Displays spot values of a Parent Frame.

•	 Exceedence Statistics Frame: Displays the statistics for an 
individually selected exceedence trace within the graph area.

•	 Exceedence List Frame: Displays a list of exceedences 
contained within the attached database.

•	 Exception List Frame: Displays a list of exception records for 
the specified thresholds for the selected channels contained 
within the parent graph frame.

•	 Trend Summary List Frame: Displays a list of sample points for 
the selected channels contained within the parent graph frame

•	 Channel List Frame: Displays a list of records for selected 
channels contained within the parent graph frame. 

•	 Channel Information Frame: Displays textual information 
regarding selected channels contained within the parent graph 
frame. 

	
NOTE: The available selections will depend on the data available in the 
recording.  If an item is greyed out it is not available.
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4.9.1	 Creating a Graph Frame

To place a graph on the page, perform the following steps:

1.	 Select the Place Graph  tool.

2.	 Move the tool to the location on the page where the upper left corner 
of the frame is to be placed.

3.	 Click and drag the mouse to the location on the page where the lower 
right corner of the frame is to be located, then release. The Channel 
Graph Properties dialog box will be displayed.

Figure 4-7

The Channel Graph Properties dialog box consists of three tabs.

Channels Tab:

•	 Choose a channel to be displayed by selecting it in the Available 
channels list, then clicking on the Add>> button. The selected 
channel will be added to the Selected channels list.
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•	 Remove channels from the Selected channels list by selecting it, 
then clicking on the <<Remove button.

•	 Change the color used to draw each of the channels by selecting it 
in the Selected channel list and choosing an alternate color from the 
Line color drop-down menu.

Figure 4-8
Scales Tab:
Specifies how the vertical scales of the associated graph are to be 
drawn.

•	 Automatically adjust vertical scale maximum: When checked, 
automatically adjusts the upper end of the vertical scale to 
accommodate the displayed channels. Remove the check to 
make the upper limit of the vertical scale fixed at the specified 
value.

•	 Enable lower limit for vertical scale maximum: When 
checked, specifies a value for which the upper end of the vertical 
scale is not allowed to go below.
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•	 Automatically adjust vertical scale minimum: When checked, 
automatically adjusts the lower end of the vertical scale to 
accommodate the displayed channels. Remove the check to make 
the lower limit of the vertical scale fixed at the specified value.

•	 Display channel units on graph: When checked, causes the 
units for each channel selected for display to be displayed on 
the left side of the graph.  When this option is selected you can 
also over-ride the default channel units and display other text as 
units. 
Note: When this option is checked, the Display channel units 
as option becomes available, allowing the entry of any text you 
would like displayed for the vertical scale units in the edit box to 
the right.

•	 Automatically adjust Start/Stop Date/Time:  Instructs 
DataView® to automatically adjust the starting or stopping time 
in the graph for displayed data to the earliest or latest sample 
point in the data to be displayed. Removing the check allows 
you to over-ride this function and manually specify a starting and 
stopping date and time.

•	 Synchronize parent/child frame display period: When 
checked, causes all graph frames linked to this frame to zoom 
and pan along with this frame.

•	 Highlight relative time period of child frames: When checked, 
causes this frame to gray the area of the frame relative to the 
child frames display period.

•	 Display upper threshold limit bar: When checked, allows you 
to specify the level and color of a line to be displayed across the 
graph. This is useful to indicate the threshold for some condition 
on the graph.

•	 Display lower threshold limit bar: When checked, allows you 
to specify the level and color of a line to be displayed across the 
graph. This is useful to indicate the threshold for some condition 
on the graph. This option, in combination with the previous 
option, allows you to indicate a band on the graph which has a 
particular importance.
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Figure 4-9
Template Tab:
Specifies how the graph should be treated when it is being opened as part 
of a template.

•	 Use template defined colors: When checked, over-rides the 
channel colors defined in a database with the colors specified in 
the Channels tab. This option will only work for channels that are 
listed in the Selected Channels list. Channels not present in that 
list will use the default color specified in the database.

•	 Delete frame if selected channel list is empty when opening 
via a template: When checked, marks the frame (and all of the 
attached child frames) for deletion if the Selected channels list is 
empty after opening via a database when used as a template.

•	 Zoom all when opening via template: Selecting this option 
will result in the graph displaying the entire range of samples 
automatically when the database is opened.
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•	 Template Filter: This option only applies when this report 
is saved as a template. It specifies how channels should be 
included when used as a template to display channels stored in 
a database. The options available are:

-	 All Channels (no filter): When selected, all channels will be 
included.

-	 Channel Type Only: When selected, any channel of the 
same type (for example voltage waveforms) as those cur-
rently selected for display will be automatically included for 
display regardless of the channels code and modifier.

-	 Channel Type and Code: When selected, any channel of 
the same type and with the same measurement code will be 
automatically included for display regardless of the channels 
modifier.  A channel code indicates the actual measurement.  
For example, Volts RMS and Volts THD each have the same 
channel type (Voltage trend) but have different measurement 
codes. 

-	 Channel Type, Code and Modifier: When selected, only 
channels with the same data type, same measurement code 
and same measurement modifier will be automatically included 
for display. For example, Volts RMS Min, Volts RMS Max and 
Volts RMS all have the same channel type and channel code.  
However they each have a different channel modifier (Min, 
Max and Avg).



DataView® User Manual	 37	

4.10	 Linking Frames (Parent and Child Frames)
The linking of frames in a report defines one frame by the contents of 
another frame.

Examples of linking Parent and Child Frames:

Example 1: An Exception Report Frame can be linked to a Graph 
Frame, which displays the trend data of a recording. The Exception 
Report Frame can be set to list exceptions for the entire recording 
or just the portion displayed in the Graph Frame, in which case, 
zooming in and out of the displayed graph will cause the exception 
report to automatically update, based on the displayed data.

Example 2: A Harmonic Text Summary frame can be linked to 
a graph displaying waveforms. When a waveform is selected, 
the Harmonic Text Summary frame will be updated based on the 
selected waveform.

In addition, multiple frames can be linked to a single frame.

Example 3: Waveform Snapshot, Harmonic Bar Graph and Har-
monic Text Summary frames can be linked to a Trend Graph that 
contains waveforms. When a waveform is selected, all three of 
the attached frames will automatically be updated for the selected 
waveform.

In Example 3, the Trend Graph is referred to as the Parent Frame. The 
Waveform Snapshot, Harmonic Bar Graph and Harmonic Text summary 
are Child Frames. In DataView® a Parent Frame can have multiple Child 
Frames, although each Child Frame can only have one Parent Frame.

Attaching a Child Frame to a Parent creates a hierarchy of linked 
frames with the top most Parent Frame controlling the display of the 
lower level frames.

NOTE: Frames that have attached Child Frames cannot be deleted 
before all of the attached Child Frames are deleted.
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4.10.1	 Creating a Linked Frame

The Link Frame tool is enabled only when a frame is capable of being a 
Parent Frame (able to support Child Frames).

Perform the following steps to link one frame to another:

1.	 Select a frame to link to using the  tool.

2.	 Select the Link Frame  tool from the toolbar and click on the 
selected frame.

The desired Child Frame Type dialog box will appear:

Figure 4-10

3.	 Select the type of Child Frame to be created and linked.

4.	 Select the OK button to proceed.

5. 	 Move the frame tool to the location on the page where the upper left 
corner of the frame is to be placed, then click and drag the mouse  
down to the location where the lower right corner of the frame is to be 
located, then release.

6. 	 The Properties dialog box, specific to the type of linked frame previ-
ously specified, will be displayed.

7. 	 Once the properties have been specified, select the OK button. The 
Child Frame is created and linked to the Parent Frame that was 
selected in Step 1.
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4.11	 Frame Types

4.11.1	 Waveform Analysis Frames
The three Child Frames listed below are linked to a Channel Graph or 
Micro-Graph Frame. They display the waveform selected in their Parent 
Frame that can be displayed in the following forms:

•	 Waveform Snapshot: Displays the selected waveform.

•	 Harmonic Bar Graph: Displays a harmonic bar graph of the 
selected waveform.

•	 Harmonic Text: Displays a harmonic text summary of the 
selected waveform.

•	 Phasor: Displays a phasor of the selected waveform.

The type of waveform analysis is specified in the associated Properties 
dialog box (see Fig. 4-11 for an example) that is displayed by either 
double-clicking on the associated frame, or by right-clicking and selecting 
Properties from the pop-up menu.

Figure 4-11
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This dialog box is used to specify the type of waveform analysis and vari-
ous display options. The options available are:

•	 Analysis Type: Contains a group of radio buttons that specifies 
the type of analysis to be performed on the associated waveform.

•	 Individual Harmonics: Contains a group of radio buttons 
that specifies how the individual harmonics are displayed in a 
Harmonic Text Summary.

•	 Phasor Rotation: Specifies the rotational order of each phase in 
a multiple phase system when the analysis type is Phasor.

•	 Zoom Parent Frame when Panning: When checked, causes 
the Parent Frame to zoom to the time period associated with the 
displayed waveform. This occurs when issuing a pan command 
while the waveform analysis frame is selected.

•	 Lock Frame Data: When checked, freezes the data used to 
display the frame at their current values. When the frame data 
is locked, selecting a waveform in the Parent Frame does not 
change the data displayed in the Child Frame.

•	 Enable lower limit for vertical scale maximum: When 
checked, specifies a value for which the upper end of the vertical 
scale is not allowed to go below.

•	 Display upper threshold limit bar: When checked, allows you 
to specify the level and color of a line to be displayed across the 
graph. This is useful to indicate the threshold for some condition 
on the graph.

•	 Display lower threshold limit bar: When checked, allows you 
to specify the level and color of a line to be displayed across the 
graph. This is useful to indicate the threshold for some condition 
on the graph. This option, in combination with the previous 
option, allows you to indicate a band on the graph which has a 
particular importance.
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To quickly move between captured waveforms, use the pan commands in 
the Zoom Menu:

       	 Pan To Start: Displays the first captured waveform.

       	 Pan To End: Displays the last captured waveform.

 	 Step Right or Step Left: Displays the next or previous  
	  captured waveform.

When stepping through the captured waveforms, the selection will move 
from each waveform for the channel associated with the currently dis-
played waveform.

After the last waveform for the current channel, the first (or last depending 
on direction of stepping) waveform for the next (or previous) channel will 
be displayed.

4.11.2	 Graph Legend Frame
The Graph Legend Frame is a Child Frame linked to a Graph Frame. It 
displays the names of the recorded channels displayed in its Parent Graph 
Frame. The name of each displayed channel is preceded by a short line 
segment drawn in the same color as its associated trace. 
The Graph Legend Properties dialog box is displayed by either double-
clicking on the associated frame, or by right-clicking and selecting 
Properties from the pop-up menu.

Figure 4-12

This dialog box has two options:

•	 Draw box around frame: When checked, a box is drawn around 
the Graph Legend Frame.

•	 Display channel units: When checked, displays channel units.
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4.11.3	 Session Summary Frame
The Session Summary Frame is a Child Frame linked to a Graph Frame. 
This frame displays a textual summary of its Parent Frame. The summary 
text is obtained from the Session Summary information entered at the time 
the recorded channel data was saved to the database.
The Session Summary Frame contains two types of text:

•	 Static text: Displayed as it was typed into the Session Summary 
Properties dialog box.

•	 Dynamic text: Generated through field substitution. The value of 
the Parent Frame of the specified field is substituted for the field 
name.

The summary text can be customized using the Session Summary 
Properties dialog box that is displayed by either double-clicking on the 
associated frame, or by right-clicking and selecting Properties from the 
pop-up menu.

Figure 4-13
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This dialog box contains:

•	 Display Text: An edit box containing the static and dynamic text 
to be displayed in the Session Summary Frame.

•	 Fields: Contains a list of field names, values and codes to select 
from.

Dynamic text is specified with square brackets around it.

Example: If the Operator Company Name field of the recorded 
data is AEMC® Instruments, placing the text [Operator Company 
Name] in the Summary Text edit box will result in AEMC® Instru-
ments being displayed in its place on the page.

Dynamic text substitution is useful for templates that create a report when 
session data is attached. The field name will reflect the name contained 
in the attached database, which may be different from database to data-
base.
Fields can be added to the Display Text edit box in the following way:

1.	 Place the cursor in the Display Text edit box where the field is to 
be inserted.

2.	 Click on the field (from the list box) to be inserted. 

3.	 This step depends on what you want inserted.  
To insert the field name as Static text, click on the Insert Field 
Name button (notice brackets are not placed around the field 
name). 
To insert the field value as Static text, click on the Insert Field 
Value button (notice that the value displayed in the list box is 
inserted). 
To insert the field name as Dynamic text, click on the Insert 
Field Code button (notice that the name of the field is 
surrounded by square brackets is inserted).

	
NOTE:  If the selected Field does not have a current value associated with it, 
the Insert Field Value button will be grayed out and unavailable.

As in any text editor, pressing the Enter key will create a new line. Press-
ing the Tab key will move the cursor to the next tab position. Change the 
default tab positions by selecting the Tabs button to display the Tabs dialog 
box.

The font used to display the text can be changed by clicking on the Font 
button and specifying the font attributes.
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4.11.5	 Meter Frame
The Meter Frame is a Child Frame linked to a Graph Frame. It provides a 
textual summary of the samples within one pixel of its Parent Frame.
The finest resolution, which the Parent Frame can draw, is one screen (or 
printer) pixel. Depending on the display magnification, one pixel width can 
contain one or more sample points. The time associated with each pixel 
position is dependent on the zoom magnification and display offset.
A vertical line is displayed in the Parent Frame at the pixel position asso-
ciated with the current meter time. Panning left and right will result in the 
vertical line moving to reflect the new position of the meter.

•	 Pan To Start: Moves the meter to the first pixel position of the 
parents graph.

•	 Pan To End: Moves the meter to the last pixel position.

•	 Pan Left and Pan Right: Step the meter up to 10 pixels left and 
right, respectively.

•	 Step Left and Step Right: Moves the meter position 1 pixel left 
and right, respectively.

	
NOTE: Panning and stepping will move in pixel increments if there is one 
or more sample per pixel location.  If there are pixels with no samples then 
panning and stepping will move to the adjacent  sample location.

The information displayed in the Meter Frame includes:

•	 The time associated with the pixel position of the Parent Graph 
Frame.

•	 The minimum, maximum and average values of the samples 
for each displayed channel for the associated single pixel time 
period.

•	 A short line of the same trace color and name of the associated 
Parent Frame trace displaying alongside the measurement 
values.

•	 The number of samples within the single pixel time period, 
indicated at the end of each trace name.

To modify any of these settings, open the Meter Properties dialog box by 
double-clicking on the Meter Frame.
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Figure 4-14

4.11.6	 Exceedence Statistics Frame
The Exceedence Statistics Frame is a Child Frame linked to a Graph 
Frame. It displays a textual summary of the exceedence trace selected 
in its Parent Frame. The displayed text is obtained from the exceedence 
trace selected in the Parent Frame.

	
NOTE: The Exceedence Statistics frame is only available if the recorded data 
contains Exceedence records.

The Exceedence Statistics Frame contains two types of text:

•	 Static text: Displayed as it was typed into the Exceedence Statistics 
Properties dialog box.

•	 Dynamic text: Generated through field substitution. The value of 
the Parent Frame of the specified field is substituted for the field 
name.

The text displayed can be customized using the Exceedence Statistics 
Properties dialog box, which is displayed by either double-clicking on the 
associated frame, or by right-clicking and selecting Properties from the 
pop-up menu.
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Figure 4-15

Text Tab:

•	 Display Text: An edit box containing the static and dynamic text 
to be displayed in the Session Summary Frame.

•	 Fields: Contains a list of field names, values and codes to select 
from.

Dynamic text is specified with square brackets around it.

Example: If the Exceedence Type field of the selected 
exceedence trace is Sag, placing the text [Exceedence Type] 
in the Exceedence Statistics Text edit box will result in Sag being 
displayed in its place on the page.

Dynamic text substitution is useful for templates that create a report when 
when you want the frame to reflect the state of the recorded data (not known 
at the time the template was created). The field name will reflect the name 
contained in the attached database, which may be different from database 
to database.
Fields can be added to the Display Text edit box in the following way:
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1.	 Place the cursor in the Display Text edit box where the field is to 
be inserted.

2.	 Click on the field (from the list box) to be inserted. 

3.	 This step depends on what you want inserted.  
To insert the field name as Static text, click on the Insert Field 
Name button (notice brackets are not placed around the field 
name). 
To insert the field value as Static text, click on the Insert Field 
Value button (notice that the value displayed in the list box is 
inserted). 
To insert the field name as Dynamic text, click on the Insert 
Field Code button (notice that the name of the field is 
surrounded by square brackets is inserted).

	
NOTE:  If the selected Field does not have a current value associated with it, 
the Insert Field Value button will be grayed out and unavailable.

As in any text editor, pressing the Enter key will create a new line. Press-
ing the Tab key will position the cursor to the next tab position. Change 
the default tab positions by selecting the Tabs button to display the Tabs 
dialog box.

The font used to display the text can be changed by clicking on the Font 
button and specifying the font attributes.
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Figure 4-16

Format Tab:
Allows you to select the type of exceedence to select when performing 
panning operation.

•	 Filter Type: The type of exceedence to select when performing 
panning operation. Choose from Surge, Sag or Both.

•	 Zoom parent frame when panning: When checked, it enables 
automatic zooming of the Parent Graph when stepping through or 
selecting exceedence events.
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4.11.7	 Exceedence List Frame

The Exceedence List Frame is a Child Frame linked to a Channel Graph 
Frame.

This frame displays a textual list of the exceedence records in the data-
base attached to its Parent Frame. The displayed text is obtained from 
the exceedence records in the recorded data contained within the Parent 
Frame.

To step between Exceedence List entries, select:

       	 Pan To Start: Displays the first exceedence event.

       	 Pan To End: Displays the last exceedence event.

 	 Step Right or Step Left: Displays the next or previous  
	  captured event.

When stepping through the captured exceedence events, the selection 
will move from each exceedence for the channel associated with the cur-
rently displayed event.

After the last event for the current channel, the first (or last, depending 
on direction of stepping) event for the next (or previous) channel will be 
displayed.

In addition to stepping through the list with the tool bar, you can select 
a specific event listed using the mouse pointer. The text for the selected 
event will be highlighted, indicating which event in the list is currently 
selected.

You can customize text displayed using the Exceedence List Properties 
dialog box, which is displayed by either double-clicking on the associ-
ated frame, or by right-clicking and selecting Properties from the pop-up 
menu.
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Figure 4-17

Format Tab:
Allows you to select the type of exceedence to filter when building the 
exceedence list.

•	 Filter Type: The type of exceedence to filter when building the 
exceedence list. Choose from Surge, Sag or Both.

•	 Sort Order: Order to display the exceedence events. Select 
an item in the Sort Order list and choose either the Promote 
or Demote button. Entries higher in the list will have a higher 
priority, the ones lower in the list will have a lower priority.

•	 Sort Type: The order the list can be displayed (sorted). Choose 
from Descending or Ascending. 

•	 List Size Limit: Limit the number of entries displayed in the list 
by entering a value in this field.

•	 Zoom Parent Frame on Selection: When checked, enables 
automatic zooming of the Parent Graph when stepping through 
or selecting exceedence events.
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Figure 4-18
Parameters Tab:
Contains a list of available and selected parameters.

•	 Available parameters: A list where a parameter can be selected 
to add to the Selected parameter list. To add a parameter, 
highlight the desired parameter, then click on the Add>> button.

•	 Selected parameter: A list of added parameters. To remove a 
parameter from the list, highlight it and click on the <<Remove 
button.

•	 Draw box around frame: When checked, draws a box around 
the resulting list table.

•	 Draw grid: When checked, draws a grid between each column 
and row of the table.

•	 Grow frame with text: When checked, the width and height of 
the frame adjusts to fit the displayed text. 

•	 Disable relative highlight of parent frame: When checked, 
disables the relative highlighting of a parent graph. When not 
checked the parent graph will highlight the region of the graph 
corresponding to the start time and duration of the selected list 
entry.
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•	 Field Width and Alignment: Sets the width of the column (or 
select auto) and alignment for each parameter.

•	 Promote or Demote: Sets the order of parameters in the 
Selected parameters list. Promoting moves a parameter higher 
in the list, demoting moves it lower.

•	 Font: Changes the font used to display the text.

•	 Load Default: Recalls a previously saved list, tab positions and 
text font.

•	 Make Default: Saves the currently selected parameter list for 
future recall.

4.11.8	 Exception List Frame
The Exception List Frame is a Child Frame linked to either a Channel 
Graph or Micro-Graph Frame.
This frame displays a textual list summary of the sample points for a 
given channel that exceed user-specified thresholds. The displayed text 
is obtained from the exceedence records in the recorded data contained 
within the Parent Frame.
To step between Exception List entries, select:

       	 Pan To Start: Displays the first exception entry.

       	 Pan To End: Displays the last exception entry.

 	 Step Right or Step Left: Displays the next or previous  
	  list entry.

When stepping through the captured exception entries, the selection will 
move from each exception for the associated channel.
In addition to stepping through the list with the tool bar, you can select a 
specific entry listed using the mouse pointer. The text for the selected entry 
will be highlighted, indicating which entry in the list is currently selected.
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Figure 4-19

Format Tab: 
Specifies the channel and limits to be used in creating the exception 
report.

•	 Database: Indicates the name of the database containing the 
recorded channel data.

•	 Selected trace: When checked, the exception report will be 
generated for the trace selected in the Parent Frame. When 
another trace is selected in the Parent Frame, the exception 
report will be updated to reflect the measurements of the newly 
selected trace.

•	 Show all: When checked, all of the recorded channels contained 
within the parents database are displayed.

•	 Available channels: A list of the channels contained in the 
Parent Graphs database.

•	 Lock frame data: When checked, the displayed exception report 
becomes locked. Changes to the Parent Frame will not affect the 
exception report.
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•	 Limit list to parent display frame: When checked, the 
exception report is limited to the zoomed section of the Parent 
Graph Frame. Any change to the zoomed state of the Parent 
Graph window will result in the exception report being updated 
for the selected time frame.

•	 Zoom Parent Frame on selection: When checked, the Parent 
Graph is automatically zoomed to the time period associated 
with the newly selected entry.

•	 Exception filter: Filters that define how the specified limits are 
to be used.
-	 Above upper limit: When selected, only the upper limit is 

used. If the Inclusive check box is selected, the exception 
report includes measurements equal to and above the upper 
limit.

-	 Below lower limit: When selected, only the lower limit is 
used. If the Inclusive check box is selected, the exception 
report includes measurements equal to and below the lower 
limit.

-	 Within upper and lower limits: When selected, both the 
upper and lower limit edit boxes are enabled. If the Inclusive 
check box is selected, the exception report includes measure-
ments that are equal to or greater than the lower limit and 
lower than or equal to the upper limit. When it is not selected, 
only values that are greater than the lower limit and less than 
the upper limit are included.

-	 Outside upper and lower limits: When selected, both the 
upper and lower limit edit boxes are enabled. If the Inclusive 
check box is selected, the exception report includes measure-
ments that are equal to or lesser than the lower limit, or equal to 
or greater than the upper limit.

-	 Inclusive: When checked, the report includes the specified 
limits.

•	 Get limits from database: Some instruments (such as the 
PowerPad) specify upper and lower exception limits when the 
database is created. When this option is checked and the limits 
are specified in the database, then those limits will be used.  
If the limits are not specified in the database, then the limits 
specified here will be used. When not checked, only the limits 
specified here will be used even if they are specified in the 
database.
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•	 Upper limit: Specifies the upper limit of the exception report.

•	 Lower limit: Specifies the lower limit of the exception report.

•	 Display limit bands: Placing a check next to this option causes 
horizontal lines at the specified limit ranges to be displayed on 
the parent graph.

•	 Enable scrolling: Placing a check next to this option causes the 
frame to only display the specified number of lines. Scroll bars 
are displayed along the right side of the frame to move through 
the list. 

•	 Window size: Specifies the maximum number of lines to be 
display in the frame for scrolling. 

By combining the Limit list to parent display frame and Selected trace 
options, the exception report will become dynamic. The associated chan-
nel and time frame are updated as you interact with the Parent Frame 
graph.

Placing a check next to Lock frame data, results in the exception report 
becoming static. The dynamic nature of the report is disabled when the 
Lock frame data option is checked. 

Figure 4-20
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Parameters Tab:
Contains a list of available and selected parameters.

•	 Available parameters: A list where a parameter can be selected 
to add to the Selected parameter list. To add a parameter, 
highlight the desired parameter, then click on the Add>> button.

•	 Selected parameter: A list of added parameters. To remove a 
parameter from the list, highlight it and click on the <<Remove 
button.

•	 Draw box around frame: When checked, draws a box around 
the resulting list table.

•	 Draw grid: When checked, draws a grid between each column 
and row of the table.

•	 Grow frame with text: When checked, the width and height of 
the frame adjusts to fit the displayed text. 

•	 Disable relative highlight of parent frame: When checked, 
disables the relative highlighting of a parent graph. When not 
checked the parent graph will highlight the region of the graph 
corresponding to the start time and duration of the selected list 
entry.

•	 Field Width and Alignment: Sets the width of the column (or 
select auto) and alignment for each parameter.

•	 Promote or Demote: Sets the order of parameters in the 
Selected parameters list. Promoting moves a parameter higher 
in the list, demoting moves it lower.

•	 Font: Changes the font used to display the text.

•	 Load Default: Recalls a previously saved parameter list, tab 
positions and  font.

•	 Make Default: Saves the currently selected parameter list for 
future recall. 

	
NOTE: Only a single default configuration can be saved at one time. Select-
ing the Make Default button overwrites the previous default configuration.
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4.11.9		 Trend Summary List Frame
The Trend Summary List Frame is a Child Frame conceived from a Chan-
nel Graph Frame.
This frame displays a textual list summary of the sample points for a given 
channel. Each summary line contains the minimum, maximum and aver-
age values of a group of sample points.
The displayed text is obtained from the combined sample points in the 
recorded data contained within the Parent Frame.

To step between Trend Summary List entries, select:

     	 Pan To Start/End: Displays the first/last list entry.

   	  Pan Right or Pan Left: Slides the view to display the graph  
	  to the left or right.

   	  Step Right or Step Left: Displays the next or previous  
	  list entry.

When stepping through the list entries, the selection will move from each 
entry for the associated channel.
In addition to stepping through the list with the tool bar, you can select a 
specific entry listed using the mouse pointer. The text for the selected entry 
will be highlighted, indicating which entry in the list is currently selected.

Figure 4-21
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The Trend Summary List Properties dialog box consists of two tabs. 

Channels Tab: 
Specifies the available summary options.

•	 Database: Indicates the name of the database containing the 
recorded channel data.

•	 Selected trace: When checked, the trend summary report will 
be generated for the trace selected in the Parent Frame. When 
another trace is selected in the Parent Frame, the exception report 
will be updated to reflect the measurements of the newly selected 
trace.

•	 Show all: When checked, all of the channels contained within the 
database associated with the parent frame are listed and can be 
selected. When not checked, the list contains only those channels 
that have been selected for display in the parent graph.

•	 Available channels: A list of the channels contained in the Parent 
Graphs database.

•	 Lock frame data: When checked, the displayed exception report 
becomes locked. Changes to the Parent Frame will not affect the 
exception report.

•	 Zoom Parent Frame on selection: When checked, the Parent 
Graph is automatically zoomed to the time period associated with 
the newly selected entry.

•	 Limit summary to parent window: When checked, the trend 
summary report is limited to the zoomed section of the Parent 
Graph Frame. Any change to the zoomed state of the Parent Graph 
window will result in the trend summary report being updated for 
the selected time frame.

•	 Summary Type: Defines how the sample points are to be com-
bined when generating the report.

-	 Average by sample count: When selected, the value con-
tained in the associated edit box is used to indicate the number 
of samples that are combined for each list entry.

	 Example: If this option is selected and the edit box contains 
10, every 10 samples will be compared for the minimum and 
maximum values to display in a list entry. Also, the 10 samples 
will be averaged for each list entry.
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-	 Average by sample period: When selected, the time period 
contained in the associated drop-down list is used to indicate 
the number of samples that are combined for each list entry. 
The actual number of samples combined will depend on the 
storage rate of the recorded data.

	 Example: If the recorded data is stored at 1-second inter-
vals and a 1-minute averaging is selected, 60 samples will be 
combined for each summary list entry.

•	 Enable scrolling: Placing a check next to this option causes the 
frame to only display the specified number of lines. Scroll bars 
are displayed along the right side of the frame to move through 
the list. 

•	 Window size: Specifies the maximum number of lines to be 
displayed in the frame for scrolling. 

By combining the Limit summary to parent window and Selected trace 
options, the trend summary report will become dynamic. The associated 
channel and time frame are updated as you interact with the Parent Frame 
graph.

Figure 4-22
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Parameters Tab:
Contains a list of available and selected parameters.

•	 Available parameters: A list where a parameter can be selected 
to add to the Selected parameter list. To add a parameter, 
highlight the desired parameter, then click on the Add>> button.

•	 Selected parameter: A list of added parameters. To remove a 
parameter from the list, highlight it and click on the <<Remove 
button.

•	 Add Space: When selected, inserts a gap in the displayed 
information.

•	 Draw box around frame: When checked, draws a box around 
the resulting list table.

•	 Draw grid: When checked, draws a grid between each column 
and row of the table.

•	 Grow frame with text: When checked, the width and height of 
the frame adjusts to fit the displayed text. 

•	 Disable relative highlight of parent frame: When checked, 
disables the relative highlighting of a parent graph. When not 
checked the parent graph will highlight the region of the graph 
corresponding to the start time and duration of the selected list 
entry.

•	 Field Width and Alignment: Sets the width of the column (or 
select auto) and alignment for each parameter.

•	 Promote or Demote: Sets the order of parameters in the 
Selected parameters list. Promoting moves a parameter higher 
in the list, demoting moves it lower.

•	 Font: Changes the font used to display the text.

•	 Load Default: Recalls a previously saved parameter list, tab 
positions and  font.

•	 Make Default: Saves the currently selected parameter list for 
future recall. 

	
NOTE: Only a single default configuration can be saved at one time. Select-
ing the Make Default button overwrites the previous default configuration.
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4.11.10	 Channel List Frame

The Channel List frame can be used independently or as a Child Frame 
linked to a Channel Graph frame. The Channel List frame displays a tex-
tual list of records for a specified list of channels.

When used independently, a database needs to be specified. When cre-
ated independently, other frames can be linked to it just as if it were a 
Graph frame.

The Channel List Properties dialog box specifies what is displayed in its 
associated list frame.

Figure 4-23

Channel List Tab:
Specifies the summary options available for the Channel List report 
frame.

•	 Database: Indicates the name of the database containing the 
recorded channel data. It is available for information only and is 
obtained from the parent trend graph.
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•	 Force display of trace: When selected, the trace for the 
selected channel record will be enabled for display in the parent 
frame even if it was not already.  This has the effect of forcing the 
display of a channel record even if previously disabled.

•	 Zoom parent frame on selection: When checked, the parent 
graph is automatically zoomed to the time period associated with 
the newly selected entry.

•	 Available channels: A list of the channels contained in the 
parent graph’s database. Select the channel(s) to be used in the 
channel list report frame. One or more channels can be selected.  
To select more than one entry, press and hold down the CTRL 
key while right-clicking a list entry.

•	 Select All: When selecting this button, all entries in the Available 
channels list will be selected for inclusion in the list frame.

•	 Deselect All: When selecting this button, all entries in the 
Available channels list will be deselected for inclusion in the list 
frame.

•	 Enable scrolling: Placing a check next to this option causes the 
frame to only display the specified number of lines. Scroll bars 
are displayed along the right side of the frame to move through 
the list. 

•	 Window size: Specifies the maximum number of lines to be 
displayed in the frame for scrolling. 
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Figure 4-24
Parameters Tab:
Contains a list of available and selected parameters.

•	 Available parameters: A list where a parameter can be selected 
to add to the Selected parameter list. To add a parameter, 
highlight the desired parameter, then click on the Add>> button.

•	 Selected parameter: A list of added parameters. To remove a 
parameter from the list, highlight it and click on the <<Remove 
button.

•	 Draw box around frame: When checked, draws a box around 
the resulting list table.

•	 Draw grid: When checked, draws a grid between each column 
and row of the table.

•	 Grow frame with text: When checked, the width and height of 
the frame adjusts to fit the displayed text. 

•	 Field Width and Alignment: Sets the width of the column (or 
select auto) and alignment for each parameter.
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•	 Promote or Demote: Sets the order of parameters in the 
Selected parameters list. Promoting moves a parameter higher 
in the list, demoting moves it lower.

•	 Font: Changes the font used to display the text.

•	 Load Default: Recalls a previously saved parameter list, tab 
positions and  font.

•	 Make Default: Saves the currently selected parameter list for 
future recall.

Figure 4-25
Template Tab:

•	 Delete worksheet this list is on when opening as a template 
and the list is empty: This option allows empty worksheets to 
be deleted automatically when creating a report from a template. 
The worksheet becomes optional and only added to the report if 
the list is not empty.

•	 Display only the first channel meeting the specified 
Template Filter: When selected, only a first channel meeting the 
specified filter will be displayed in the resulting channel list. This 



DataView® User Manual	 65	

option, when used in conjunction with the next option, results in 
multiple worksheets with one for each of the channels meeting 
the specified template filter.

•	 Duplicate worksheet for each channel meeting the specified 
Template Filter: When selected, a worksheet will be created for 
each channel meeting the specified template filter. This option, 
when used in conjunction with the previous option, results in 
multiple worksheets with one for each of the channels meeting 
the specified template filter.

•	 Template Filter: This option only applies when the report 
is saved as a template. It specifies how channels should be 
included when used as a template to display channels stored in 
a database. 
The options available are:

-	 Channel Type Only: When selected, any channel of the 
same type (for example voltage waveforms) as those cur-
rently selected for display will be automatically included for 
display regardless of the channels code and modifier.

-	 Channel Type and Code: When selected, any channel of 
the same type and with the same measurement code will be 
automatically included for display regardless of the channels 
modifier.  A channel code indicates the actual measurement.  
For example, Volts RMS and Volts THD each have the same 
channel type (Voltage trend) but have different measurement 
codes. 

-	 Channel Type, Code and Modifier: When selected, only 
channels with the same data type, same measurement code 
and same measurement modifier will be automatically included 
for display. For example, Volts RMS Min, Volts RMS Max and 
Volts RMS all have the same channel type and channel code.  
However they each have a different channel modifier (Min, 
Max and Avg). 
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4.11.11	 Channel Information Frame

The Channel Information frame is a child frame linked to a Channel Graph 
frame. The Channel Information frame displays a textual summary of the 
channel record trace selected in its parent frame. The displayed text is 
obtained from the trace selected in the parent frame.
The Channel Information Frame contains two types of text:

•	 Static text: Displayed as it was typed into the Channel Information 
Properties dialog box.

•	 Dynamic text: Generated through field substitution. The value of 
the selection in the Parent Frame of the specified field is substituted 
for the field name.

The text displayed can be customized using the Channel Information 
Properties dialog box, which is displayed by either double-clicking on the 
associated frame, or by right-clicking and selecting Properties from the 
pop-up menu.

Figure 4-26

•	 Channel Types: Contains a list of channel measurement types. 
Each measurement type has its own substitution text.
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•	 Display Text: An edit box containing the static and dynamic text 
to be displayed in the Channel Information Frame.

•	 Fields: Contains a list of field names, values and codes to select 
from.

Dynamic text is specified with square brackets around it.

Example: If the DAR field of the selected megohmmeter test 
measurement trace is 1.000, placing the text [DAR] in the Chan-
nel Information Text edit box will result in 1.000 being displayed in 
its place on the page.

Dynamic text substitution is useful for templates that create a report. The 
field name will reflect the name contained in the attached database, which 
may be different from database to database.
Fields can be added to the Display Text edit box in the following way:

1.	 Place the cursor in the Display Text edit box where the field is to 
be inserted.

2.	 Click on the field (from the list box) to be inserted. 

3.	 This step depends on what you want inserted.  
To insert the field name as Static text, click on the Insert Field 
Name button (notice brackets are not placed around the field 
name). 
To insert the field name as Dynamic text, click on the Insert 
Field Code button (notice that the name of the field is 
surrounded by square brackets is inserted).

As in any text editor, pressing the Enter key will create a new line. Press-
ing the Tab key will position the cursor to the next tab position. Change 
the default tab positions by selecting the Tabs button to display the Tabs 
dialog box.

The font used to display the text can be changed by clicking on the Font 
button and specifying the font attributes.
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4.11.13	 Bar Chart Meter

A Bar Chart Meter frame displays individual sample points for a selected 
point in time on a graph in bar chart format.  A bar for each channel is 
displayed with the bar for the corresponding channel representing the 
value of the sample point for the selected time point of the parent frame. 
The Bar Chart Meter frame is similar to the Meter Frame (that displays 
textual values) the Bar Chart Meter displays sample values in a bar 
representation.

As with graph frames, you can customize the channels that are displayed 
and the colors of those channels. The Bar Chart Meter frame allows the 
following frames to be linked to it:

•	 Channel Information: Displays information about the selected 
bar.

•	 Graph Legend: Displays a legend for the bars being displayed.

•	 Session Summary: Displays summary information about the 
recording session.

A bar can be selected by positioning the mouse pointer over the desired 
bar and clicking the left mouse button. If a Channel Information Frame is 
linked it will be updated to display information about the selected bar.

Fig 4-27
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Channels Tab:

•	 Choose a channel to be displayed by selecting it in the Available 
channels list, then clicking on the Add>> button. The selected 
channel will be added to the Selected channels list.

•	 Remove channels from the Selected channels list by selecting it, 
then clicking on the <<Remove button.

•	 Change the color used to draw each of the channels by selecting it 
in the Selected channel list and choosing an alternate color from the 
Line color drop-down menu.

Fig 4-28

Scales Tab:
Specifies how the vertical scales of the associated graph are to be 
drawn.

•	 Automatically adjust vertical scale maximum: When checked, 
automatically adjusts the upper end of the vertical scale to 
accommodate the displayed channels. Remove the check to 
make the upper limit of the vertical scale fixed at the specified 
value.
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•	 Enable lower limit for vertical scale maximum: When 
checked, specifies a value for which the upper end of the vertical 
scale is not allowed to go below.

•	 Automatically adjust vertical scale minimum: When checked, 
automatically adjusts the lower end of the vertical scale to 
accommodate the displayed channels. Remove the check to make 
the lower limit of the vertical scale fixed at the specified value.

•	 Display channel units on graph: When checked, causes the 
units for each channel selected for display to be displayed on the 
left side of the graph. 
Note: When this option is checked, the Display channel units 
as option becomes available, allowing the entry of any text you 
would like displayed for the vertical scale units in the edit box to 
the right.

•	 Automatically adjust Start/Stop Date/Time:  Instructs 
DataView® to automatically adjust the starting or stopping time 
in the graph for displayed data to the earliest or latest sample 
point in the data to be displayed. Removing the check allows 
you to over-ride this function and manually specify a starting and 
stopping date and time.

•	 Display upper and lower threshold limit bar: Allows you to 
draw a horizontal line at the specified limit level and color. The 
limit bar is drawn for reference only and is not used to analyze 
the selected channels.
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Fig 4-29

Template Tab:
Specifies how the graph should be treated when it is being opened as part 
of a template.

•	 Use template defined colors: When checked, overrides the 
channel colors defined in a database with the colors specified in 
the Channels tab.

•	 Delete frame if selected channel list is empty when opening 
via a template: When checked, marks the frame (and all of the 
attached child frames) for deletion if the Selected channels list is 
empty after opening via a database when used as a template.

•	 Zoom all when opening via template: Selecting this option 
will result in the graph displaying the entire range of samples 
automatically when the report is initially created from a template.
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•	 Template Filter: This option only applies when this report 
is saved as a template. It specifies how channels should be 
included when used as a template to display channels stored in 
a database. The options available are:

-	 All Channels (no filter): When selected, all channels will be 
included.

-	 Channel Type Only: When selected, any channel of the 
same type (for example voltage waveforms) as those cur-
rently selected for display will be automatically included for 
display regardless of the channels code and modifier.

-	 Channel Type and Code: When selected, any channel of 
the same type and with the same measurement code will be 
automatically included for display regardless of the channels 
modifier.  A channel code indicates the actual measurement.  
For example, Volts RMS and Volts THD each have the same 
channel type (voltage trend) but have different measurement 
codes. 

-	 Channel Type, Code and Modifier: When selected, only 
channels with the same data type, same measurement 
code and same measurement modifier will be automatically 
included for display. For example, Volts RMS Min, Volts RMS 
Max and Volts RMS all have the same channel type and 
channel code.  However they each have a different channel 
modifier (Min, Max and Avg). 
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4.11.14	 Session List Frame

The Session List frame displays a textual list of session records for a 
specified database.
This dialog box consists of two tabs.

Figure 4-30

Session List:
Specifies the summary options available for the Session List frame. The 
items in this dialog box are defined as follows:

•	 Database: Indicates the name of the database containing the 
recorded channel data. It is available for information only and is 
obtained from the parent trend graph.

•	 Force display of trace: When selected, the traces for the 
selected session record will be enabled for display in the child 
frame(s) even if they were not already.  This has the effect 
of forcing the display of channel records even if previously 
disabled.

•	 Zoom child frame on selection: When checked, the child 
frame(s) are automatically zoomed to the time period associated 
with the newly selected entry.
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•	 Enable scrolling: Placing a check next to this option causes the 
frame to only display the specified number of lines. Scroll bars 
are displayed along the right side of the frame to move through 
the list.

•	 Window size: Specifies the maximum number of lines to be 
displayed in the frame for scrolling.

Figure 4-31

Parameters Tab:

•	 Available parameters: A list where a parameter can be selected 
to add to the Selected parameter list. To add a parameter, 
highlight the desired parameter, then click on the Add>> button.

•	 Selected parameter: A list of added parameters. To remove a 
parameter from the list, highlight it and click on the <<Remove 
button.

•	 Draw box around frame: When checked, draws a box around 
the resulting list table.

•	 Draw grid: When checked, draws a grid between each column 
and row of the table.

•	 Grow frame with text: When checked, the width and height of 
the frame adjusts to fit the displayed text. 
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•	 Disable relative highlight of parent frame: When checked, 
disables the relative highlighting of a parent graph. When not 
checked the parent graph will highlight the region of the graph 
corresponding to the start time and duration of the selected list 
entry.

•	 Field Width and Alignment: Sets the width of the column (or 
select auto) and alignment for each parameter.

•	 Promote or Demote: Sets the order of parameters in the 
Selected parameters list. Promoting moves a parameter higher 
in the list, demoting moves it lower.

•	 Font: Changes the font used to display the text.

•	 Load Default: Recalls a previously saved list, tab positions and 
text font.

•	 Make Default: Saves the currently selected parameter list for 
future recall.
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4.11.15	 Table of Contents Frame

The Table of Contents frame displays a textual list of worksheets and their 
associated page numbers.

Figure 4-32

•	 Available parameters: A list where a parameter can be selected 
to add to the Selected parameter list. To add a parameter, 
highlight the desired parameter, then click on the Add>> button.

•	 Selected parameter: A list of added parameters. To remove a 
parameter from the list, highlight it and click on the <<Remove 
button.

•	 Add Space: When selected, inserts a gap in the displayed 
information.

•	 Draw box around frame: When checked, draws a box around 
the resulting list table.

•	 Draw grid: When checked, draws a grid between each column 
and row of the table.
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•	 Grow frame with text: When checked, the width of the frame is 
maintained and the height is adjusted to fit the displayed text. 

•	 Field Width and Alignment: Sets the width of the column (or 
select auto) and alignment for each parameter.

•	 Promote or Demote: Sets the order of parameters in the 
Selected parameters list. Promoting moves a parameter higher 
in the list, demoting moves it lower.

•	 Font: Changes the font used to display the text.

•	 Load Default: Recalls a previously saved list, tab positions and 
text font.

•	 Make Default: Saves the currently selected parameter list for 
future recall.
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CHAPTER 5

OBJECTS

5.1	 Object Linking
When an OLE item is placed in the report, it can be copied into or linked 
to the original file.

•	 When copied into the report, changing the original file will have 
no effect on the object in the report.

•	 When linked to the file, any changes made to the original file 
results in the embedded object changing, as well.

Using the OLE  tool, click on the report where you would like to place 
the image.

The Insert Object dialog box will appear:

Figure 5-1

This dialog box specifies the object and how it is to be attached.
•	 Create New: Creates a new object to insert on the page.

•	 Object Type: This list is available when Create New is selected. 
This list consists of applications for creating a new object.
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•	 Create From File: Choose this option when placing an existing 
object. Use the Browse button to locate the file.
Place a check beside the Link option to maintain a link to the original 
file. If this option is not checked, then the object will be embedded 
(copied) into the report.
When an object is linked, it can be customized using the Links com-
mand in the Edit menu.

Figure 5-2

•	 Display as Icon: When checked, specifies whether the embedded 
object will appear in the report as an icon or as the actual object. 
When checked, a Change Icon button will be available. Click this 
button to specify the icon to be displayed for the object.

Figure 5-3
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•	 Current: Displays the icon that will appear in the current 
document.

•	 Default: Specifies that the icon representing the embedded or 
linked information in the document is the default icon for the 
program that was used to create it.

•	 From File: Specifies that the icon will be chosen from a different 
location.

•	 Label: Provides a space to type a label for the icon as it will 
appear in the document. A default label is used unless it is 
changed.

5.2	 Object Editing
The Object option in the Edit menu is grayed out until an object is selected 
on the page. This option will then change to reflect the type of OLE frame 
selected.

Example: When selecting a bitmap linked object, the Object option in the 
Edit menu will be replaced with the text Bitmap Image Object. This option 
has  three submenu commands:

•	 Edit: Opens the object file for editing. If it is a linked object, then 
the application will be started and the corresponding link file 
loaded into it. If the object was copied into the report (not linked), 
then it will be opened for in-place editing.

•	 Open: Starts the corresponding application to edit the object 
regardless of whether it is a link or copy.

•	 Convert: Displays the Convert dialog box. This dialog box lists 
the types of format conversions available.

	
NOTE: Double-clicking on a linked image will open the source program it 
was created in for editing.
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Figure 5-4

The Links dialog box displays the current links used in this document, 
their type, and update status. If the source file for the link can not be 
found, the update column will read Unavailable. This typically happens if 
the source file is on an unavailable network drive, or if the source file has 
been moved.

•	 Cancel: Click this button to close the Links dialog box before any 
changes are made. Once a link is modified, the Cancel button is 
replaced with the Close button. This indicates that changes have 
been made and applied to the selected link(s).

•	 Update Now: Click this button to update the selected link if any 
changes have been made to it. This option only needs to be 
used if Manual is selected at the bottom of the dialog box. If 
Automatic is selected, the link is updated automatically.

•	 Open Source: Click this button to open the file of the selected 
link.

•	 Change Source: Click this button to change the selected object 
to a different one.

•	 Break Link: Click this button to remove the connection between 
the selected link and the source file. When the link is broken, the 
frame becomes a static object and can no longer be edited.
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CHAPTER 6

TEMPLATES

DataView® comes with a set of templates, each for a specific type of instru-
ment and configuration.

A template is a file that defines the type, placement and properties of 
frames in a report. It is used to generate a report for a database when 
performing any of the following methods:

•	 Downloading instrument data
•	 Opening a template
•	 Opening a database

6.1	 Create Report from Template
The Create Report from Template dialog box selects, in one-place, tem-
plate and database files to be joined to create a report.

1.	 Select the New from Template option from the File menu.

Figure 6-1
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This dialog box contains the following items:

•	 Select Instrument: Lists the product groups found in the 
Templates directory.

•	 Select Template: Lists the templates within the selected group.

•	 Template Browse Button: Allows the selection of a desired 
template file from a location on a computer.

•	 Database Browse Button: This button (located next to the 
Database list box) allows the selection of the desired database 
files.

•	 Database List Box: Lists the specified database files that are to 
be used to generate the report.

2.	 Specify the template to use.

3.	 Specify database (or databases) to be used in the creation of the 
report.

4.	 Select the OK button.

Each step must be completed in order. The controls for each step are dis-
abled until the preceding step is completed.

6.2	 Attaching a Template when Downloading Data
A template can be attached to a database at the time the database is 
created.

	
NOTE: Results may vary depending on the type of instrument used.  
Refer to the Help file from within the instrument Control Panel for the  
specific procedure for this section.

To download (by the instrument’s Control Panel), save and view data from 
an instrument, perform the following steps:

1.	 Select Download from the Instrument menu. The Connection dialog 
box is displayed.

	 NOTE: If the default configuration has been set to automatically estab-
lish a connection, the Connection dialog box will not appear.

2.	 Select the communications port and rate from the drop-down menus.

3.	 Select the OK dialog button. A connection with the instrument will be 
established and any data currently stored in it will be downloaded.
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4.	 Once the download is complete, the Save As dialog box will be 
displayed. Specify the name to save the database under, then select 
Save.

5.	 Specify the Session Properties.

6.	 A dialog box will be displayed, indicating the success or failure of the 
data decode process. Assuming the data decode was successful, 
select the OK button and continue. If an error was reported, resolve 
the error before proceeding.

7.	 Answer Yes to the question, “Do you want to open database just 
downloaded?” The Create Report from Template dialog box will be 
displayed.

8.	 Select the template to use for the initial display of the database, then 
select OK.

9.	 Customize each object frame as desired.

Once the Create Report from Template dialog box is closed, the result-
ing report will be displayed.

6.3	 Attaching a Database when Opening a Template
In order to properly open a template it is necessary that a database is 
attached. First, select the desired template. Second, specify the desired 
database(s).

To open a template and create a report, perform the following steps:

1. 	 Select Open > Open Template from the File menu.

2. 	 Select or specify the name of the template file.

3. 	 Select the Open button. The Create Report from Template dialog 
box will be displayed.

4. 	 Specify the name of each database file needed to complete the trans-
formation of the template to a report (see § 6.1).

5. 	 Select the OK button.

6. 	 Customize each object frame as desired.

Once the Create Report from Template dialog box is closed, the result-
ing report will be displayed.
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6.4	 Attaching a Template when Opening a Database
When a database is opened, the user is asked to supply the name of the 
template to define its display. When the template is specified, it is attached 
to the database resulting in a report.

To open a database and create a report, perform the following steps:

1. 	 Select Open > Open Database from the File menu.

2. 	 Select or specify the name of the database file.

3. 	 Select the Open button. The Create Report from Template dialog 
box will be displayed.

4. 	 Select the template to use for the initial display of the database  
(see § 6.1). 

5. 	 Specify any additional databases (if any) required by the selected 
template.

6. 	 Select the OK button.

7. 	 Customize each object frame as desired.

Once the Create Report from Template dialog box is closed, the result-
ing report will be displayed.

6.5	 Creating a Template
A template is created when a report is saved with the database.

To create a template, perform the following steps:

1. 	 Open an existing report or create a new one. 

2. 	 Modify the report as desired. 

3. 	 Select the Save As Template option from the File menu. 

4. 	 Specify the name of the template in the File name field. 

5. 	 Select the Save button. 
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6.6	 Modifying a Template
To modify a template, perform the following steps:

1. 	 Select Open > Open Template from the File menu.

2. 	 Select or specify the name of the template file.

3. 	 Select the Open button. The Create Report from Template dialog 
box will be displayed.

4. 	 Specify the name of each database file needed to complete the trans-
formation of the template to a report (this step will be skipped if the 
template was saved with the database embedded it it).

5.	 Select the OK button.

6. 	 Customize each object frame, as desired.

7. 	 Save the report as a template, using the name specified in Step 3.

A new template, based on an existing template, can be created using the 
previous procedure, except specify a different name in Step 7. The original 
template will be left as is and a new one with the specified name will be 
created.
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